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Upgrade Warnings: Please Read Before Upgrading
You must have already upgraded to Fusion Installer 3.1 on all computers, including the server.
You must ensure there are no paused or incomplete chuteside jobs or they will be lost.
After the upgrade, it can take Fusion Server a few hours to upgrade your data so we suggest
beginning the upgrade as early in the afternoon as possible. This applies especially to larger sites
with lots of data.
All of your chuteside job definitions will be converted to the new system. Please be aware that this
conversion is not perfect, so expect to take some time to go through each job definition before using
it.
If you are upgrading from Fusion 2.5.1 or earlier, you will see a dialog when you first launch Fusion
Server or Fusion Truck after the upgrade. The dialog will say, "This data file is going to be converted
to work with 4D Application v13." Just click the OK button. This means that you will need to
manually upgrade Fusion Server so that you are there to click the button.

List Window Features
In order to accommodate very wide headers, a lot of list columns were very wide even even when
the values in the column were narrow. This version allows for taller headers with multiple lines, so
many columns have been reformatted. This should make it so that you can see more data in lists
without scrolling.
Lists now have the ability to lock one or more of the left most columns so they don't scroll during
horizontal scrolling. Where it makes sense, lists will now have locking turned on by default.
Advanced list views now give you the ability to control the row height and vertical alignment for
header and body rows. You can also change how many columns are locked for your custom views.
Important note: If you have saved views or default views set, Fusion will attempt to update them to
have the new column widths and labels and column locking. If you have changed any column labels
they will be changed back to the original values. You may need to modify some of your saved views
after the upgrade.
When you open the Advanced View window for a list, the "Slowness" column has been updated with
correct information. This will give you an indication of which columns you may not want to use
except when you really need them because of how they may slow down list drawing.
When you click the gear button in any list window, two or three help options have been added. The
first one is "General List Windows Help" which shows a help page explaining the features common to
all list windows. The other two options show help specific to this list window (if it has been created)
and a list of all the possible fields in the list along with their descriptions. Please note that most lists
do not have anything in their help pages yet, but we will be filling in this information over the next
few versions.

Feeding Features
There is a new window called Manual Feed Entry which can be found in Fusion Feed→Feeding. It
makes it easier to enter feed manually when a truck computer is not working and feeding is being
tracked by hand.
The Mix Load window has seen some changes. Four buttons (Apply To Different Ration, Repair
Ration, Add Note, and Manual Entry Mode) are now under a new gear button to take up less room. A
new button named Add Precise Amounts has been added. The user will need the proper permissions

to use this feature. It makes it possible to tell Fusion about amounts being added to the load that
are too small to register accurately with the scale system. It can also be used to tell Fusion about
larger amounts where you know precisely how much was added, such as from a micro mix machine.
When you click the button, any ingredients in the ration with no weight added will be shown. You
can then enter the correct amount for each as you physically add it to the load. You also have the
option of adding ingredients that are not part of the original ration and setting their target and
actual amounts. When you finally deliver the load, Fusion will make adjustments internally so it is as
if you hit Record Weight at the perfect moment after adding the small ingredients. Note that these
ingredients will be recognized as added manually in the Daily Feed Detail window.

Animal Related Features
An animal may now belong to multiple lots over its history, including at different locations. When an
animal belongs to more than one lot, you can always see its full history, but each lot will only be
billed for items that occurred during the time the animal belonged to it. An animal can also not
belong to any lot for a period of time, although this means that any items associated with the animal
during that time will not be billed anywhere. To accommodate this functionality, the following
changes have been made:
The Movement History section of the Animal History window now shows a list of lots the
animal has belonged to, similar to the list of pens the animal has belonged to. This list is
editable so you can change the current lot the animal belongs to as well as add and delete
other lots. An animal cannot belong to more than one lot on a single day.
Places in Fusion that used to show an animal's location and lot now show it as the animal's
current location and lot.
A new field in the Animal list shows the number of lots the animal has belonged to in its life. It
is called Lot Count.
The inline links between animals and lots (and visa versa) have been updated so you can
choose between viewing the current lot/animals or all lots/animals.
The animal Bulk Update window now allows you to either change the current lot for the
animals (old behavior) or "move" the animals to a new lot on a specified date.
As explained further in the chuteside section below, you can now sort animals into lots during
a job and there is no longer a requirement for an animal to belong to a lot at all during a job.
The animal Bulk Update window now has a help button with detailed help available. We will try to
add similar help pages to a few windows each release.
In the Job History section of the Animal History window, you can now double-click an event and
Fusion will open the chuteside event inspector.
An animal can now have a cattle type associated directly with it instead of just through the lot.
Hopefully this will make current and future reporting easier for some things. During the upgrade
every animal will be assigned the cattle type of the lot it belongs to. You can change an animal's
cattle type in the History window, the Bulk Update window, the Grid Edit window, chuteside jobs,
and through a file import.
Similar to cattle type, animals can also have a source associated directly with them which can be
changed in the same places. During the upgrade, Fusion will automatically set the source for all
animals based on the source field of the in cohort the animal is associated with, or, if it isn't linked
to an in cohort, based on the lot's buyer or originating herd, in that order.
Additional inline links between contacts, cattle types, and animals have been created.
Both the cattle type and source are now included in the Lot Info Export file.
Fusion can now keep track of pen and feed bunk density information for both animals and lots. This
includes the following related changes:
The pen edit window has a place to enter each pen's length, width, and bunk length. (There is
a place to do this in the Setup Assistant for new users as well.) If you make a change to a
pen's dimensions you will be asked how much history you want updated when saving the pen.

Pen day summaries now show the pen and bunk densities for each day for the pen. These are
updated whenever a move happens.
The Pen list window now shows the current pen and bunk density. This is automatically
updated whenever a move happens.
Lot day summaries now show the average (over the life of the lot) pen and bunk densities for
each day for the lot. If a lot is in multiple pens on a day, the respective densities are weighted
by count. These are updated whenever a move happens.
The Lot Center window now shows the average pen and bunk densities (over the life of the
lot) and the standard deviation of each in the production area of the list and in the Production
area of the Detail Area. These can also be included in Print Detail reports. This information is
updated each night.
The Animal list window now shows the average pen and bunk densities (over the life of the
animal) and the standard deviation of each. This information is on the Animal History window
as well. It is based on the movement history of the animal so animals in the same lot may
have different values based on whether they have been to the sick pen, for example. This
information is recalculated each night.
Density information for both lots and animals is now included in the Lot Info Export file.
There is a new utility available at Fusion Admin→Utilities→Pen Dimensions Conversion Utility
to make it easy to start using the density information for existing customers. It is meant to be
a one-time-use utility. Use it to enter the dimensions for all your pens at one time and then
Fusion will calculate all density information for your entire history at one time. This may take
up to an hour or two, so you should do this at the end of a day, but it is the most efficient way
to get started.

Chuteside Features
Much of Fusion Chuteside has been rewritten offering you far more control over chuteside jobs. The new
system is sufficiently different that Fusion is not able to perfectly convert your old jobs to the new system.
No information will be lost, but we encourage you to take the time to redo your job definitions. We also
encourage you to get a good handle on the changes explained below you you can take advantage of the
new features.
These release notes do not try to cover every single change or new feature in chuteside, nor do they go
into a lot of detail. Many of the chuteside windows now have help buttons where features are explained in
detail and we refer you to them for more information.
Job Definitions
The job definitions are now shown in a regular list window where you can search, edit, and
even duplicate them. You don't need to worry about keeping old jobs around because each
chuteside batch and event remembers the entire job definition as it was when the job ran and
will allow you to see its full history even if the job definition itself has been deleted.
Fusion now keeps track of how often a certain job is run and when it was last used.
The Job Definitions list window has an Options button that leads you to the HUD window list
and editor. HUD windows are also explained more elsewhere. Please note, though, that the
HUD editor will be available in a future version. This Options button also leads you to a place
for programming electronic keyboards which can be used to enter information at chuteside
faster.
Creating and editing a job now happens in its own window. Following are some of the
highlights that are different from before:
A job definition can now be tied to a location. If it is, it will only be available to
computers at that location.
A job (and some subjobs) can be assigned a billing category. When this is done, drug
and input events created from the job/subjob will use this billing category rather than

the one entered when the drug/input was defined. This means the Lot Center and other
windows and reports that break drugs down by billing category have changed slightly
and now allow the same drug to be in multiple categories.
A job can be set up to require elevated permissions to begin. This kind of job must be
setup by someone in the group with permission to do so.
Any job, including one started with elevated permissions, can be added to a job queue.
This means that you can setup several jobs in the office exactly the way you want and
then add them to the queue for the crew to perform later on. They can also be set so
that only someone with elevated permissions can actually finalize the job after reviewing
it. (A urgent message and a text message will be sent when this job is ready for
review).
A job can automatically create in cohorts based on new animals as well as sort them into
lots.
ID stacks take the place of automatic sequence generation for animal IDs and is much
more flexible and consistent.
New subjob types have been added including setting the estimated slaughter date,
ultrasound, setting custom fields and setting genetic fields. In addition, the attributes
subjob now allows setting more attributes such as source, cattle type, hip height, and
more.
All subjobs can now have their label changed. You also have control over whether a
subjob shows up in the synopsis window (HUD, now) and whether it is hidden. Hiding a
subjob can help clear up the clutter during a job. For example, an input subjob that is
only there for billing purposes can be hidden so the crew working the job doesn't see it.
You can ask Fusion to automatically apply inputs to subjobs that are added on the fly so
the crew doesn't have to remember to adding the billing subjobs related to something
they added on the fly.
You have complete control over which windows are part of a job and how they are
positioned on the screen.
You have extensive control over sorting. You can now create as many sort protocols as
you want. Each sort protocol has any number of sort groups an animal will fall into. You
define which criteria apply for a sort protocol. The list of possible criteria numbers more
than 150 and you can use them in any combination you like. You then tell Fusion which
sort group each variation falls into. You also define which subjobs (if any) fall under
each sort group. This is similar to how treatment protocols are setup, but easier and
more flexible.
One of the new subjobs available in a sort group is a flag. When a flag occurs you can
have Fusion throw a huge blinking dialog on screen and blink the DSI lights to get your
attention. Because flags are just subjobs within sort groups, you can have Fusion flag
you for almost any situation you like.
More of the definition options can be set to be changed during job setup. This should
make it easier to set up generic jobs. Instead of changing the job definition itself often,
you only need to adjust the job setup itself.
Because there are so many job definition options, we recommend creating a few job templates
and then duplicating and fine tuning them for specific job type.
There are several changes with the Job Batches list window:
A job can have many more status' than before so you can see if it is in process, paused,
waiting for review, finalized, etc. You can also see how many animals are in a job and this
updates live during the job.
The job now keeps track of who started it, who ran it, and who finalized it and this information
is available here.
Fusion now keeps an audit trail for each job so you can see who did what each step of the

way. This is a field that can be printed and it is available from the new View menu.
The View menu allows you to see a job's statistics. This is similar to the old job statistics but
with more information about the individual events within the job. You can now print this
information in a simplistic form.
The View menu allows you to see the job's definition as it was when the job was going on.
You can use the View menu to get a list of animals that were in the job (or use a child
window).
The Chuteside Events list window is more useful. Double-click an event (or click View Event) and the
job definition window will open showing exactly how the job was set up when this animal entered
(the job definition can change during the course of a job if the Job Setup window is used to change
things). It also shows an inspector which shows all the information for each subjob in the job for this
animal including information never previously shown. This should help track down issues in the
future.
There are now a few different ways of starting a job:
Use the Start Job menu button. If you do this from an office computer you will first be given a
choice of locations to choose from. Whether in the office or at chuteside, the next choice will
be to resume a paused job, start a job in the queue, or start a brand new job. Based on which
you choose, you will then be given a choice of which job or job definition within that category
to choose from.
You can select one or more animals in the Animal List window and then choose Start A Virtual
Job From Selected Animals from the Modify menu. You will then be asked to choose a job
definition. Virtual jobs work almost identically to normal jobs, except that Fusion knows which
animals will be in the job ahead of time. They can also be performed automatically which is a
quick way of doing some things in the office.
Note that job definitions which require elevated permissions will not show for starting new jobs
unless the user logged in is in a group which allows this.
When you start a new job, the first thing you will see is the Setup Window. This window has all the
setup options consolidated into one window with a list of things that can be set on the left and the
actual settings on the right. You can make what changes you want and then start the job or add it to
the job queue to do later or for someone else to do. If you are starting a job that was previously
paused, placed in a queue, or waiting for review, you will not see the Setup Window when you start.
Once the job is ready to start, all the windows for this job are opened where you desire them. You
will notice that the different parts of the old job windows have been broken up so that you can size
and rearrange them more efficiently for each job. One window type in particular, the Heads Up
Display or HUD is very different from before in that you can completely customize what it looks like
and it is possible to have multiple HUD windows open at the same time. More on this is explained
later.
When a job starts, it now starts before the first animal. This is especially useful when starting jobs in
the queue or in odd situations where Fusion often went to the second animal before you had a
chance to do anything. It will now stay on animal zero until the Next button is clicked or the RFID
reader detects a new tag.
The Job Controller window (the one with the Next button on it) has a gear button with a lot of
options on it. Some of these were available before, so are not explained here, but some are new:
You can review the animals in the job in an easier way. This option will show you a list of all
the animals in the job so far with pertinent information listed. To revisit an animal, simply
select it. Another option takes you back to the current animal in the chute.
You can view the job stats live during the job. Fusion will calculate them and display them in a
window. This includes information about each sort group.
When you ask to modify the job setup, you are now shown the same Job Setup window as
explained above so you can change anything you want in one place.
Depending on the situation, this button allows you to pause, send for review, finalize, or
cancel a job. For example, if this is a job that required elevated permissions to begin and had

been placed in a job queue with a finalization request, the only option for the crew would be to
send it for review. Someone with elevated permissions would then review the job and either
finalize it or pause it so it could be sent back and continued.
You can enter a special mode for easily moving windows. When you do this, every chuteside
window becomes yellow and you can drag the window from anywhere in the yellow. After a
window is moved, its position is remembered for that job type on that computer for the future.
Use the gear button again to leave this mode.
You can also ask Fusion to reset the position of all the windows in case they aren't where you
want them.
You can now have Fusion attempt reconnecting to an RFID reader or temperature probe
during a job if the connection was lost.
If the job is a virtual job, the gear button will have an option for Fusion to go through all the
animals automatically.
In the past, Fusion had an area that showed some information about each animal during the job. It
also had an area that showed a synopsis of what was supposed to happen to the animal. Both these
ideas (and more) have been combined into the idea of a Heads Up Display (HUD) window. You can
define as many HUDs as you want and each can be a different size. Each HUD can have one or more
pages on it which you can scroll through. Fusion comes with a few pre-defined HUDs and, in a future
version, you will be able to create your own HUDs. Following is a bit of information on each page
type available in a HUD:
The Event Synopsis page is the same as the old synopsis window. It shows a list of major
things that need to be done to the animal. The job definition give you more control over which
subjobs might send information to the Synopsis Page than before.
The Running Totals page shows the count, average weight, and total weight for all animals in
the job as well as a break down for each sort group. At any point during the job you can select
the total or a sort group and reset the count and weights. You can also toggle between seeing
the information since the last reset or the total information.
The Animal Job History page shows the same information as the the Job History area of the
Animal History window so you can quickly see what jobs the animal has been in before and
what happened without having to manually look up its history.
Similarly, the Animal Movement History page shows the pen and lot movement history for the
animal.
The Animal Withdrawal History page shows a list of all the drugs the animal has had and the
withdrawal for each. They will be in red if a withdrawal is still in affect.
A HUD can also have several custom pages. A custom page is one that you create. There are
over 150 types of information about the animal that you can choose from and you choose
where it goes, how big it is, etc. You can even define an alternate view for each field. For
example, you may want the temperature field to turn red if it is over a certain value. The
ability to actually edit custom HUDs will be in the next version (we ran out of time with this
version).
If you are using a DSI at chuteside, Fusion will now take advantage of its bright lights to give you
job status information without having to look at the computer. We recommend mounting the DSI on
a wall within the field of vision of the person who is letting the animal out of the squeeze. If the DSI
is showing a green light, Fusion is happy it has all the information it needs. If it is showing a red
light, there may be an issue that needs to be fixed before releasing the animal. As mentioned
previously, flags can also cause the DSI to blink different colors of lights.
There is a new contact chooser available for touchscreens which is is use in the Animal Attributes
subjob for changing the Source field. This window uses several mechanisms to make it fairly easy to
select the contact you are interested in quickly. Two in particular are worth mentioning:
The left side of the window lists all the "categories" of contacts that you have defined. If you
haven't put your contacts into categories yet, we recommend that you to so—at least for a
buyer or source category—as it will make contact selection during a job much easier. Select

the category on the left and just the contacts from that category will show up on the right.
There is a special category named "Recent Contacts". Once you launch Fusion Client, Fusion
starts remembering every contact you choose and keeps it in this list until you quit Fusion
Client. So if a job uses a handful of contacts, the first time you need to select each contact
make take a few touches to find it. But after that it will be in the Recent Contacts category so
you can quickly select it.
Depending on how your job is set up, when the job is about to be finalized Fusion will collate all the
animal movements and offer to make actual pen movements. This process has been reworked
slightly and should be more reliable than before. Fusion can also create new in cohorts from new
animals in the job.
If you have more than one sort protocol defined in a job, one of them will be the primary one.
Fusion give you the chance to store the active sort group from this protocol with the animal and also
into one of the five custom fields if you like. This give you a chance to do different things with the
animals in different sort groups after the job is complete since you can easily query for all the
animals from a certain sort group in the Animal List window.
Note that the Treat Animal subjob protocols are now based on the animal's DOF, Days to Slaughter,
and Cattle Type instead of the animal's lot.
Fusion can now be connected to an electronic keyboard. You will have to purchase the keyboard, but
it can be customized to fit your feedlot's needs. More information on this is available from the help
button at Fusion Admin→Chuteside Jobs→Options→Edit Keyboard Profiles→New.

Scale System Features
Fusion now supports Digi-Star and similar indicators which you can use instead of a DSI or LCIB.
The setup window for these has a help button which explains in detail what types of indicators are
supported. Our current recommendation is to use these kinds of scale heads in trucks and DSIs at
chuteside.
If the scale settings file is corrupt, Fusion is better at detecting that and restoring as much
information as possible from an older copy.
Several new troubleshooting tools are now available:
When logging weights from LCIBs or DSIs we now capture when Record Weights happen.
A new option that allows the scale to be adjusted for drift is available. For trouble shooting
only.
When using a DSI, a new option from the Scale Indicator window Info button allows you to
force setting the gain the correct value for the calibration. This also works in Raw mode. This
is for trouble shooting only.
There is now an option to make sure the gain setting isn't too high during a DSI calibration.
When restoring DSI calibrations, it is now possible to restore with a different gain setting.
A new "Special Logging" function is available for the scale system when using a DSI.

General Features
Fusion is now compatible with Windows 8.
Ability to send a text to users who are the recipient of an urgent message from the Message Center.
A new field for the special email address needed for this is available in the User edit window. Urgent
messages sent from the server are also texted where set up.
The print preview capability has been drastically enhanced in Windows as it now uses Microsoft's
native XPS viewer. Note that this comes by default with Windows 7, but may need to be installed
from Microsoft on Windows XP and Vista.
When printing advanced print reports on Windows, you can now access the Progress dialog to stop
the printing during the data collection stage.

Added five new fields to the Lot Day Summary list which show the principle pen, all the pens, all the
pens with the count, all the pens with the weight, and all the pens with both count and weight on
any specific day. This will be especially helpful when you open this list as a child list to the Lot
Center window and use these new fields to see what pens the lot was in over the life of the lot.
Similarly, the Pen Day Summary list has these new fields, but for the lots within the pen on a
specific day.
Lot Protocol actions will now track the name of the user who "completed" the action. This is available
in the Lot Protocol Action list window as well as in the Lot Edit window. Only actions completed after
the upgrade will have users attached to them.
Advanced Print reports now track who they were created by and when they were created as well as
who last used the report and when that was. They also keep track of how many times a report has
been used. This information should make it easier to clean up reports that aren't being used. In the
Advanced Print window, you can scroll the report list to the right or expand the window to see this
information. You can also use the gear icon to automatically expand/contract the report list. (Note
that inline reports may be called several times during the printing of a parent report, but the usage
count will only increase by one for them as well.) Unfortunately, there is no past history of this
information, so it will only start after you upgrade.
The keyboard that shows up when you need to type something on a touchscreen has allowed you to
create phrases that can be inserted with just two clicks, but it hasn't been possible to manage these
phrases. There is now a gear icon that allows you to add new phrases (based on the selection of
text, like before), insert phrases from the remembered list (like before), and delete phrases from the
list which you no longer want to use. Currently these phrases are the same across all computers and
locations. We would be interested in feedback to know if it would be better to have these phrases
remembered locally on the specific computer or based on the user logged in. Let us know if you
have a strong preference.
What we used to call User Rights and Designations have been renamed. Instead of a user having a
Designation, users now belong to a group. And instead of creating Designations with user rights, you
now create groups with permissions. The Group Permissions window (what used to be the User
Rights window) has been changed a little to be easier to use and now includes a help page. Note
that many permissions have been added to provide for more fine grained control. This includes
splitting some permissions into several permissions. You may need to revisit the permissions to
make sure they are still correct for your users.
Advanced Print calculated columns can now be rounded to the nearest 50 or 500.
When Fusion Server notices a new version of Fusion is available, it can now use the HTTP protocol to
download the install files. This should be more reliable and may be faster. If necessary, the protocol
can be specified in the Auto Upgrade window.
Moved to HTML release notes for easier readability. You can also open the release notes in a web
browser for printing.
If a server crashed during the night and is relaunched in the morning, it will now skip any nonessential nightly routine work so you can start using Fusion again sooner.

Bug Fixes
The wrong weight would be calculated for iFHMS out cohorts. This has been fixed.
If a load was deleted, the inventory numbers did not update correctly. This is fixed.
In the Animal List window, the "Age (CCIA Months)" column was incorrectly calculating the number
of months from the In Date instead of the Birthdate. This is fixed.
The arrow keys and delete key would not work when editing a Lot Info Export filename. This is fixed.
When writing checks in Fusion Commodity, if a scale ticket had an overridden discount price, this
wasn't taken into account. This is fixed.
On some systems the scale settings preference file occasionally becomes corrupted. This would
cause Fusion to not be able to use the scale. Fusion now tries to detect this situation and will at least

allow you to set the scale settings back up without having to manually delete the corrupt preference
file.
The menu items at the top of list windows haven't shown their help tips when you hover the mouse
over them for several versions. This is fixed.
If you tried to edit something, like a pen or lot, and the only thing you changed was something to
upper or lower case, the information would not be saved. For example, if you had a pen named
"test" and tried to change it to "Test" without changing any other information, the pen would not be
saved. This is fixed.
When a lot has multiple ownerships and if the date ranges are just right, the Customer Invoice
window can show the incorrect owner(s) for the lot. This is fixed.
Rewrote the temperature probe reading logic to fix odd situation bugs. When starting a chuteside
job an additional option can be used to turn on temperature probe logging. This should only be used
for troubleshooting purposes.

